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5 Days Lesson Plan
Resume Website Project

Phillip Schein

This project provides students with a real-world experience using web technologies to 
achieve some business objective. Students work through an website project life cycle of 
involving the design, implementation, and marketing of an own online resume promoting 
their professional work and personal achievements.  The project goal is to have each 
student  

• Complete an entire project life cycle  
• Experience role-playing of both creator/designer and reviewer/critic in the 

launching of an online site 
• Have online deliverables at the completion of the project that demonstrates 

their competency  
 

Resume Project Lab 1 Objectives (Proposal/Functional Design - Site): Completion of 
a personal resume in the form of a marketing plan, mind mapping this plan to a website, 
storyboard the website, and select structural layout and appropriate styles. 
 
Resume Project Lab 2 Objectives (Structural Design/Implementation - Site): Having 
determined functional characteristics and structural layout, students will create a 
Dreamweaver template used throughout the website. Techniques such as 
locking/unlocking of regions and use of common graphic elements such as banners will 
maintain web site consistency.  
 
Resume Project Lab 3 Objectives (Structural Design/Implementation - Page): 
Students will apply structural elements such as frames, borders, icons and software 
controls to create a flexible and easily user interface within each page. This lab stresses 
the importance of positional awareness and "summary to detail" concepts within the 
pages themselves.  
 
Resume Project Lab 4 Objectives (Quality Assurance Review – Site/Page): During 
this phase, the site is judged for consistency, coherency, and relevancy. Additional 
content that provides good resume writing techniques are applied.  Links will be created 
to other website projects students have completed during the program for perspective 
employers to view. 
 
Resume Project Lab 5 Objectives (Deployment - Presentation): Each student will 
have 15 min in length to “market” themselves and their online resumes. Presentation will 
include the marketing plan, the website, and a brief verbal explanation of purposes and 
benefits to classmates in a mock interview/press conference situation. This presentation 
and all its elements will also be judged for consistency, coherency, and relevancy. An 
additional 15 minutes will provide the opportunity for the audience to critique the 
student’s entire “marketing package”.  Students will have the opportunity to videotape 
their presentation for follow-up review. 
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Lab 1 Goal 
These five labs will demonstrate your proficiency in completing each stage in the life 
cycle of proposing, designing, and marketing an ecommerce website. You will use your 
personal resume as the content source; this site will promote “yourself” to perspective 
employers/clients. Your resume is a description of yourself as an employable “product”. 
The first stage in this lifecycle begins with the completion of a marketing plan and the 
functional design of your website. This marketing plan will be the blueprint that guides 
you through the entire process, as well as the tool you will use to measure your success in 
completing your objectives and achieving your goal of attracting an employer/client. 
 
Objectives 
You will create a marketing plan based on your personal resume that will, through the use 
of mind mapping techniques, provide the content for a website. The plan, based on your 
resume, will state the intended goal, your target audience, benefits/advantages you offer 
to accomplish your goal for your target audience, and materials supporting your proposed 
benefits/advantages. You will organize and select content within your plan to determine 
the structural design of a website and specific site specifications.  You will then build a 
storyboard based on this content following your design specifications. In order to 
determine style and format, you will select the “feel” of your website that you believe is 
appropriate for your target audience.  Examples of online resumes are included below 
under Online Resume Examples in the Additional Resources section of this lab.   
 
Topics Covered 
Topics covered in this lab include 

Creation of a marketing plan • 
• 
• 
• 

Using mind mapping that plan to a website 
Creating a storyboard detailing the content of a website 
Applying design principles to the structural specifications of a website in order to 
accomplish specific mission objectives, maintain internal coherence and 
consistency, and provide benefits to a target audience 

 
Requirements 
You will need a completed personal resume. 
You will create a marketing plan.  
You will mind map this marketing plan to a storyboard.  You can either manually create 
this storyboard or use Microsoft PowerPoint (95 or later) to import your marketing plan 
document saved in RTF or MS Word file format.  
 
Instructions 
Section 1: Creating your personal resume. 
Choose between either a chronological or functional ordering of information. Your style 
of presentation can range from a formal, conservative presentation to a more creative, 
informal recitation of facts. Remember to include internships, membership in 
professional associations and even other non-relevant professional experiences. It is 
important that you use as many nouns as possible. Unlike hardcopy resumes that 
emphasize the use of “action verbs” like “achieved” “created”, “generated”, and 
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“published”, you will need as many “key words” as possible to optimize mind mapping 
your resume to a website. Verbs are NOT key words. 

 
Step 1: Use either a chronological or functional format to write a one-page 
resume that includes your objective in distributing this resume, a summary of 
your skills, your professional experiences, your level of formal education, and any 
other appropriate background information supporting your stated objective. Your 
resume should include the following sections: 
 
Objectives or Profile “I am seeking full-time employment... 
Skills and qualifications “I have designed various websites… 
Education or Professional 
Experience 

“I have a AA from Heritage College… or “I 
have a BA from University of Rochester” 

Additional Information “I have CIW certification… 
“Find additional information at  
  www.about-mywork.com” 

References “Furnished upon request… 
 

Step 2:  Print this resume. Think of this resume as the description of a product.  
Hold this document in your hand as if you were the intended recipient of this 
resume and the potential consumer of this product. This document describes the 
content of webpages within your website. It is also a document you will provide 
to perspective employers/clients upon request. This document must look 
professional in appearance, functional in terms of format and style, and concise 
and relevant in terms of content.   
 
TEST YOURSELF: Does the information included within the resume support 
the stated objective at the top of the page?  Does the organization of information 
help “dramatize” the advantages/benefits stated in the content of the resume?  
Does the most relevant information supporting the stated objective “jump out” of 
the two-dimensional page? Would you as a potential employer or “consumer” of 
this information want to receive additional information about the promised 
advantages/benefits described in this document? 
 

Section 2: Create a marketing plan based on your resume. Conceptualize your resume 
as a description of a “product” you want some target audience to need, want, or hire. You 
want an employer or client to hire you. You are going to use a variety of media to “sell” 
this product; one medium will be the Internet. Remember that given the nature of an 
online resume, this website will only develop interest in you as a “product”; you will 
have to close the “sale” in person.  

 
Step 1: Create a market plan based on your personal resume. Your market plan 
should include the following sections: 
 

Objectives: General and specific Search for consulting jobs… 
Product/Services to be promoted Web design, Web marketing… 
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Competitive Environment Compared to others, candidate can… 
Marketing Strategy The most appropriate industry is… 
Measurement Criteria CIW certification, … 
Staffing Information Biographical info includes… 
Budgets and Schedules Candidate seeking $60K, will travel 

   
Unlike your resume, which describes a “product”, your marketing plan formalizes 
where and how you will “sell yourself”.  This marketing plan is a formal 
document that can also be used to support your “worth” as an “employable” 
product since it is a major component of any business venture. You will complete 
this plan in no more than one to two pages by writing a brief paragraph for each 
of the above sections. Refer to Market Plans in the Additional Resources section 
of this lab for additional assistance. 
 
Step 2: Print this market plan. This document, like an architectural blueprint, 
provides critical structural information that you will use to determine your site 
configuration.  Hold this document in your hand as if you were a venture 
capitalist and potential investor in the marketing of this “product”.  Have you 
adequately completed each section of the plan using simple, declarative 
statements that provide information to your reader?  How thorough have you 
described your competitive environment?  For example, what is the median salary 
of web designers in central eastern states?  What key attributes distinguish your 
“product” from other websites marketing similar “products” based on this and 
other demographic information?  Have you found two or three other examples of 
websites that have similar marketing objectives?  Does your formal plan provide 
you with enough information, independent of the product description itself, for 
you to make a presentation to a roomful of potential investors? 
 
TEST YOURSELF:  Unlike “brick and mortar” commercial ventures that stress 
location, location, location, ecommerce market plans stress target audience, target 
audience, target audience. How did you select your target audience?  What 
resources did you use to research this audience? How comprehensive was that 
research? What marketing strategies are you using that incorporate information 
about that target audience?  The greater your knowledge of the audience to whom 
you are directing your marketing message, the greater probability your website 
will succeed in its stated marketing objective. Whether or not a marketing plan is 
successful, a potential employer can evaluate its originality and organization in 
support of your resume and as part of your quest to finding employment.  

 
Section 3: Mind mapping Your Website 
Mind mapping is a design technique that translates linear ideas into a non-linear form that 
better accommodates the nature of the Web Wide Web. You can use either your resume 
or your marketing plan to translate information into “content with form”; this form will 
become the structure of your website. Since your resume describes a “product”, mapping 
its information would result in a bottom up design beginning, mostly with individual 
webpages. If you use your marketing plan, the mapping will generally work from a top 
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down approach focusing more on the outer boundaries of the website. Each document 
complements the other and is treated in exactly the same way when you apply the mind 
mapping technique. 

 
Step 1: Start of the top of the document and circle all individual nouns as you 
read through the text to the bottom of the document. For example, you would 
draw a circle around the word “web” AND a separate circle around the word 
“designer”. 
 
Step 2: Return to the top of the document and circle compound words. For 
example, you would draw a circle around the compound word “web designer”. 
 
Step 3: Transpose all circled words to a separate clean document that will allow 
the repositioning and rearrangement of “key word” concepts.  Thus, for example, 
your list will include the words “web”, “designer”, “web designer”, “Las Vegas”, 
“University”, and “Heritage College”. 
 
Step 4: Rearrange your “key words” as conceptual groups that have relationships 
to other groups of key words. These relationships must have meaning to your 
target audience. For example, if your target audience is undergraduates at the 
University of Richmond there is a meaningful relationship between “University of 
Richmond” and “web designer”. If you are marketing business-to-business 
services to the greater Richmond area, an association with “Richmond” is a better 
choice because a perspective business client might only have interest in your 
affiliation with the Heritage College as biographical information. 
 
Step 5: Draw a circle around these larger clusters of key words. These circled 
“key words” form a cluster diagram of your proposed website. Each cluster 
contains nouns drawn from your resume and market plan that your target audience 
will recognize as a meaningful conceptual unit of related information. You will 
also notice that some clusters are closely related to other clusters. Where 
appropriate, you can also draw larger circles around closely related clusters.   
 
Step 6: This document, often times called a cluster diagram, is a part of your web 
design specifications. These circled clusters form web pages within your website.  

 
Notice how Figure 1 - An example of a free-hand cluster diagram is a simple free hand 
document containing many important details about how a website is constructed. The 
web page entitled My Professional Experience includes a heading, Internet-related work, 
that links to a separate page; My Web Work.  My Hobbies and My Education form other 
clusters within the website that are separate from My Professional Experience.  Notice 
how some topics point outside the website, such as Finance/Accounting and Univ. of 
Richmond.  Notice how a simple resume has branched out across several pages. 
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Figure 1 – An example of a free-hand cluster diagr
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Step 1: Identify the clusters that will appear on separate webpages by some 
identifying name. This name does not have to be the future title of the webpage 
but should be the file name under which the page will be saved. 
 
Step 2: Using the cluster diagram, specify the logical linking of clusters from the 
perspective of your target audience by arranging the individual webpages in some 
sequence on yet another blank page.   
 
TEST YOURSELF: Examine the overall flow of linkages, especially if the 
information flow is hierarchical, for branching symmetry and balanced access.  
Information flow will follow any one or a combination of three basic patterns:  

• A cul-de-sac - The conceptual passageway with a distinct single entrance, 
will guide the your audience in a constrained, though not necessarily linear 
way, to the center of your website. This design is well suited for the 
treatment of complex and/or structured information. 

• A pincushion - A more porous site design, with many access points, will 
provide cued navigational choices to your audience. This more subtle 
design provides “choices” to your target audience but nevertheless affords 
you control over the information flow. This model is best suited for 
complex but unstructured information such as in a database of information 
or retail site.  

• A cloud - This web design, with little controlled access control, has links 
pointing in both an inward and outward directions. Navigational cues 
pertain primarily to the individual web pages rather than the website as a 
whole.  This model is the least structured and does not lend itself to 
providing an organization presentation of information. 

 
Section 6: Determining style and format of your website.  
Web design includes more than just visual layouts.  The usability of a specific website on 
the Internet is affected by the context within which a webpage in that website operates.  
Navigational or user choices are “clear” to the “average” user because most pages in 
websites share a similar context of providing information.  You have built your site based 
upon relationships among pages you assume your target audience will make within the 
context of the information content you provide. You provide content on these webpages 
and choices to your target audience for retrieval of information (content). The majority of 
publicly accessible websites are “easy to use” because they target similar audiences with 
similar expectations. The synergy of context, content, and choice thus work together 
almost subliminally providing what your audience will perceive of as an “intuitive” 
interface. You need to decide on a consistent context for your website within which to 
present both choices and content on each page.  When designing a website for a client, it 
is a recommended practice to list these design specifications stating how you will apply 
style and format issues at both the site and page level. 

 
Step 1: Select the placement of contextual and navigational cues on a typical page 
in your website. Oftentimes, designers diagram how they arrange common 
elements on a webpage in the form of Web Design Specifications.  They indicate 
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for example, where a banner and navigational cues will be placed on the page. 
This simple list of specifications should accompany the marketing plan.  
 
Deviation from some common context thus confuses, distracts, or “frustrates” 
your audience because they do not share the “context” within which choices to 
retrieve content are provided. Thus, issues of positional awareness of, for 
example, navigational cues and other choice points, are predicated upon the 
context that you are sharing with your audience. For example, traditional page 
design includes head, body and foot. Links to contextual information within or 
outside a website are typically located in the head section of a webpage; 
navigational cues for movement within the same page or site are usually placed in 
the foot of the page. Placement of these choices somewhere else on a webpage 
may confuse or distract your audience.     
 
Step 2: Select the placement of choice, content of choices that relate to authorship 
and/or administrative or technical support.  This may include links to email 
contact, sponsoring institution, whether this page is under the “official” purview 
of some sponsoring body, dates of creation and/or revision, statement of 
ownership, appropriate use, and copyright information.  For example, 
 

Copyright © 2000 by My Company (mysite.com). You can use 
content on this page for any educational or not-for-profit purpose.  
Provided “as is” without expressed or implied warranty. 

 
Step 3: Select the general specifications such as page length (affecting retrieval 
time and usability), page grids (consistent patterns promote a sense of coherency), 
typography (font styles and sizes), graphic sizes (within the context of some 
chosen grid pattern), and the use of linkages to other pages both within and 
outside your webpage and website.  You need some consistent policy regarding 

• Links into and out of a webpage and your website 
• Links within blocks of text 
• Links anchored to non-textual elements like icons 
• Link maintenance and updating 
• Types of websites and kinds of material to which links point (for example, 

home pages of other sites or documents within those sites, commercial 
sites, adult sites, children sites, “controversial” sites, and so on.) 

 
TEST YOURSELF: Which kind of link will require more long-term 
maintenance: www.mysite_index.com or www.mysite_mypersonalideapage.com? 
Remember that it is less likely that a link to an index page of a commercial or 
more “traditional” site will require long-term maintenance due to filename or 
location changes. Links to individual web pages within a site may require more 
long-term maintenance than the page’s provided content is “worth”.  
 

© 2003 Phillip G. Schein.   All Rights Reserved.   Page 8 of 21 



Conclusion 
You have completed the Planning phase of your ecommerce project.  In this phase of the 
project you specify purpose, objective, and design specifications. The purpose is your 
intention of why the website exists.  The objective is your intention of what 
benefits/advantages the website offers some target audience. The design specification 
includes details regarding how and under what constraints your content and choices will 
be presented. 
 
At the conclusion of this lab, you have compiled the following documentation: 

1. Personal resume (maximum one page) 
2. Marketing plan (maximum 2-3 pages) 
3. Cluster Diagram  
4. Storyboard 
5. Design specifications for both site and page level  

 
Additional Resources 
 
Online Resume Examples 
http://www.products2market.com/marketing.htm 
An example of online resume for a marketing consulting company.  Notice the 
Consultant’s Bio in the navigational bar on the left side of the page. 
 
http://ehomesonoma.com/Resume.html 
An example of online resume using a similar traditional format. Notice the placement of 
“I offer” and “Qualifications” columns on the page. This is the actual Resume webpage. 
Notice the Realty Solutions button, linking to the “homepage”, in the navigational bar on 
the left side of the page. 
 
http://www.lynnb.com/ 
An example of online resume using a more traditional format but with less information 
about the individual.  
 
Good Resume writing 
http://www.jobweb.com/catapult/guenov/restips.html 
Before you begin writing your resume, this site outlines some preliminary steps you may 
want to follow. 
 
http://owl.english.purdue.edu/handouts/pw/index.html 
Purdue Online Writing Lab offers many features including a section on Professional 
writing/Resumes 
 
Creating Marketing Plans 
http://home3.americanexpress.com/smallbusiness/resources/starting/biz_plan/ 
American Express provides consulting services to small businesses. They offer 
information regarding the construction of business plans that include marketing sections. 
http://www.rcacwv.com/plan.htm building a marketing plan  
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Mind mapping Techniques 
http://www.cedarnet.org/mar/OR.HTM 
This site shows examples of a dynamic flowchart design as compared to an organization 
time line.  Could you use a timeline to creatively “market” the idea of your availability as 
a candidate for some job? 
 
Storyboard Techniques 
http://www.mcli.dist.maricopa.edu/authoring/studio/guidebook/storyboard_example.html 
Explore the examples of storyboards on this site. Who is the target audience here?  Notice 
how a slight change in orientation of navigational choices imparts a different “feel” and 
flow to the webpages. 
 
http://www.iastate.edu/~polsci/storyboard.html 
These detailed storyboard examples are not “formal” but incredibly functional. Notice 
how they include a broad range of information. Could you design a website based on this 
“informal” storyboard? Do you need fancy software to compile web specifications? 
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Lab 2 Goal 
These five labs will demonstrate your proficiency in completing each stage in the life 
cycle of proposing, designing, and marketing an ecommerce website. The second stage in 
this lifecycle begins with applying your storyboard and design specifications at the site 
level. In order to maintain consistency across the website, you will create a template in 
Dreamweaver.  You will use various techniques, such as locking and unlocking specific 
areas on a page and, common elements, such as navigational cues, to maintain 
consistency with the specifications you chose in the last lab.   
 
Objectives 
Create a template in Dreamweaver to help maintain consistency throughout the site. 
Apply this template to existing webpages so that all webpages provide similar a common 
context and “intuitive” choices. Create editable sections in the template to accommodate 
variations in design without a significant deviation from the web specifications.  
 
Topics Covered 
Topics covered in this lab include 

Creating of a Dreamweaver template from both existing content and from scratch  • 
• 
• 
• 

Applying a template to an existing webpage 
Editing the original template 
Marking a selection as editable 

 
Requirements 
You will need Dreamweaver version 3 installed on your personal computer. 
You will need to define a website before Dreamweaver can insert a template. 
 
Instructions 
Section 1: Creating a Dreamweaver template. 
While Dreamweaver is an excellent software product, any web page authoring tool can be 
used to build your actual website. 
 

Step 1: Launch Dreamweaver, and if you want to use an existing webpage, open 
that page in Dreamweaver. 
Step 2a: Select Save As Template in the File Menu and enter a meaningful name. 
A copy of that page will be saved in the Templates subdirectory in the root of 
your website. 
Step 2b: If you are building a template from scratch, select New Template at the 
bottom of the Template palette and enter a meaningful name. This template will 
be saved in the Templates subdirectory in the root of your website. 
Step 3: Double click the newly created template in the Template palette.  It will 
open in a separate Document window. 
Step 4: Insert and arrange the common elements according to your design 
specifications.  
Step 5: Close the Document window and save the template.  The message stating 
that your template has not editable regions means that all the objects are locked in 
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place and that the template will prevent any change in the general context and 
choices. 

 
Section 2: Making existing regions editable.  
When you create a template, all regions by default are locked.  You must mark regions as 
editable in order to allow “moves, additions, or changes” in the choice or content.  When 
you make a change to a “locked” region in the original template, all webpages that are 
linked to that template will also reflect the change.  This is how context, choices, and 
your content are maintained in a consistent manner. 

 
Step 1: To make a “locked” region editable, open the template and the select the 
region you want to modify. 
Step 2: Select Mark Selection as Editable in the Templates submenu under the 
Modify menu and give the region a meaningful name.  This region will be listed 
at the bottom of the Templates submenu in the Modify menu.  You can mark an 
entire table or an individual cell within a table but you are not able to mark 
multiple cells as editable at any one time. 
Step 3:  Select the region in the menu in order to highlight the area in the 
Document window and make the necessary changes.   

 
Section 3: Make a new editable region on your web page. 
In using a template, you might decide to control, for example, just gridlines or the page 
structure, or a masthead.  You need to unlock or make editable other regions so that your 
client or user population can customize a page within the constraints of your website 
specifications. 
 

Step 1: To create a new editable region in a template, select New Editable Region 
from the Templates submenu in the Modify menu and name the region a 
meaningful name. 
Step 2: To lock a region that has been previously marked as editable, select 
Unmark Editable Region from the Templates submenu in the Modify menu. 
Step 3: Select the name of the region you wish to relock and return the region 
back to an uneditable state. 

 
Section 4: Apply a template to a web page. 
Sometimes a client has developed his or her own page. They would you to include it in 
the web site.  Application of your web specifications through the use of a page template 
simplifies your work and provides your client or user population with a sense of 
contribution and responsibility. 
 

Step 1: You can drag a template from the Template palette and drop it to an 
existing webpage to apply the template specifications. An alternative method is to 
select Apply Template to Page from the Templates submenu in the Modify menu. 
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Section 5 Make changes to a template. 
Oftentimes a successful template will need minor updating in order to maintain its 
relevancy and/or freshness. You will need to method to make simple changes that are 
replicated throughout your website.  Always check what effects a “simple” change in a 
template may have on the layout of complex pages. 
 

Step 1: Open a template in the Template palette or from the Site Manager to add 
or make changes to its content. 
Step 2: When you make changes to locked objects in a Template, the changes are 
applied to all pages linked to that template.  When you edit editable, unlocked 
objects in a Template, the changes are NOT applied to webpages linked to that 
template. 
Step 3: If you make changes to a template after it has been applied to webpages, 
Dreamweaver will prompt you to update all the pages linked to the template in 
order to apply the new changes.  

 
At the conclusion of this lab, you have a series of web pages that conform to your web 
design specifications. 
 
Additional Resources 
 
Online graphic resources 
http://www.macromedia.com/software/dreamweaver/download/templates 
Macromedia provides various areas on its website to download additional material for its 
software products.  Notice the section for downloads at the top of the page. 
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Lab 3 Goal 
These five labs will demonstrate your proficiency in completing each stage in the life 
cycle of proposing, designing, and marketing an ecommerce website. In this third stage of 
your project’s lifecycle, you build individual webpages based on your storyboard and the 
Dreamweaver page template consistent with your design specifications. Concepts such as 
positional awareness and the transition of content from “summary to detail” help you 
design the appropriate placement of content and choices across webpages within the 
general context of your website. 
 
Objectives 
You will select from a variety of structural elements like frames, borders, icons and 
controls to create flexible and easily navigable pages of content.  Sources for web design 
are listed in the Additional Resources section of this lab.   
 
Topics Covered 
Topics covered in this lab include 

Creation of frames • 
• 
• 
• 

Creation of borders 
Creation of icons 
Creation of controls 

 
Requirements 
You will need Dreamweaver version 3 or greater. 
 
Instructions 
Section 1: Create frames in your webpage.  
Frames help to organize a page layout.  It is a common practice in the production of 
newspapers and magazines to provide a grid against which all graphic and textual objects 
are spatially positioned. Frames as a design element may be problematic for a target 
audience who has not standardized their Netscape or Internet Explorer software on 
version 3 or later because earlier versions of the Internet client cannot render frames 
correctly.   

 
Step 1: Create a new document. 
Step 2: Select the pattern of splitting your page by making a selection from the 
Frameset submenu under the Modify main menu. 
Step 3: Click inside an existing frame and repeat the process of making a 
selection from the Frameset submenu under the Modify main menu. 
Step 4: Select Save Frameset under the File main menu to save the frameset as a 
document. 
Step 5: Add content by clicking inside a frame. 
Step 6:  When you are finished, select Save from the File main menu. 
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Section 2: Creating borders in your web page. 
Using borders as a graphic element can provide greater usability through subtly cueing 
user regarding the prominence of some graphic element or text.  Conversely, too many 
borders will disrupt a page’s perceived integrity. 
 

Step 1: Select an image you wish to modify in the Document window. 
Step 2: Select an option from the Align drop down list in Properties Inspector or 
right click on the image and select an option from the cascading menu that opens 
when you trace down to Align in the context menu. 
Step 3: Since, by default, a border surrounds frames, select No from the borders 
pull-down menu in the Properties Inspector to turn them off. 
Step 4: When using tables, click Select Table in the Table submenu under the 
Modify main menu. 
Step 5: On the Properties palette, change Border (space around the table) and Cell 
Pad (space within a cell).  

 
Section 3: Placing icons and controls in your web page. 
The placement of icons and controls must agree with the context of your site in order to 
optimize your significance to your viewer. Their consistency of placement and design 
will provide a greater sense of coherence and consistency. 
 

Step 1: To place images on a webpage, select Image on the Insert main menu. 
You can also single click the Insert Image icon in the Objects palette. From this 
Objects palette, you can insert special typographical characters, common objects, 
forms, frames, and special control elements such as keywords (Head) and 
comments (Invisible).  
Step 2: To collect objects for future insertion in your webpages, select Library 
under the Window main menu. 
Step 3: Click and drag some third-party image into the lower windowpane of the 
Library palette. Give the icon that appears a meaningful name. 
Step 4: To add a library item to a document, click and drag that item from the 
Library palette list to the document. 

 
At the conclusion of this lab, you have completed your website according to your web 
design specifications. 
 

 
 
Additional Resources 
http://dir.yahoo.com/Computers_and_Internet/Data_Formats/HTML/Guides_and_Tutorials/ 
Paste the above URL directly into your web client’s Address or Location box to directly 
access Most Popular Sites for HTML guides and tutorials.  Webmonkey, Builder.com 
and the Yale Web Style Guide should be familiar websites to you. 
 
http://www.hooked.net/ 
Use this site to find information about HCI (human computer interface). This site is not 
exactly Yahoo but, then again, this content is not directed toward the “average netizen”. 
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Notice the vocabulary.  It is important that you remember the average reading level of 
Americans is at the 5th to 6th grade level.  HINT - Use “Math & Computer Science” 
under “Reference & Education” to find really HOT stuff about web content.  If we 
commonly associate passion and excitement with heat, why would I want to show you 
KOOL stuff? Could you get HOOKED on this site? Based on that association, will you 
remember the site name now?  
 
http://us.mediametrix.com/data/thetop.jsp 
This is a direct link to the top 50 digital media/web properties at home and at work 
combined in the US. Notice how this page does NOT contain a linked list.  Who is the 
target audience? Why are there no links?  HINT: Is this information useful to the 
“average netizen”? 
 
http://www.webpagesthatsuck.com/ 
A significant site to supplement materials in this program pertaining to principles of good 
web design.  You regrettably might want to return their book after visiting this site. Resist 
the temptation; computer keyboards and mice don’t work well when you are spending 
some time in a bathroom.  If you own a laptop, you can afford to spend money on the 
book! 
 
The following sites all provide additional resources, tutorials, and background materials: 
http://www.freewebmaster.com/index2.html 
http://web-helper.net/ 
 
Tools 
http://www.psptips.com/ 
This site is an excellent resource for Paint Shop Pro. 
 
http://www.grafx-design.com/Home.html 
Look for product specific tutorials here. 
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Lab 4 Goal 
These five labs will demonstrate your proficiency in completing each stage in the life 
cycle of proposing, designing, and marketing an ecommerce website. The fourth stage in 
this lifecycle is an evaluation phase where the context, content, and choices of your 
website are evaluated in terms of your marketing plan and design specifications. 
 
Objectives 
Students should spend this day adding content, It will be helpful to include some 
references to good resume writing techniques, It would also be great to add a link to their 
completed website for prospective employers to view.  Reference materials are included 
below under in the Additional Resources section of this lab.   
 
Topics Covered 
Topics covered in this lab include 

Apply web design principles to context, content, and choices in a website. • 
 
Requirements 
You will need a completed market plan. 
You will need web design specifications. 
 
Instructions 
Section 1: Reviewing the context, choices, and content of a website for coherence 
and consistency. 
Quality assurance is a critical process in a life cycle. Before a “product” is released as a 
“beta” version to a controlled test population, it is internally reviewed in an “alpha” stage.  
You need to examine your own design in as critical and unbiased manner as possible.  
When you are satisfied with your work, you “release” your “product” to a test population 
who will “measure” your final product in terms of its own internal consistency as well as 
against what you specified in your marketing plan and web design specifications as 
having intended to do for yourself, your employer, or your client. 
 

Step 1: In order to confirm usability, perform a thorough walkthrough of your 
site, systematically checking every task. List the path you follow and the 
navigational choices you make for later reference when you construct a Usability 
Test. In order to confirm the use of proper semantics, check navigational choices 
for clarity and logic. Check context choices according to your Link policies. 
Check the graphical/iconic meaning of your choices. 
 
Step 2: You need to have other people test usability of your website to determine 
whether your selected context is consistent and choices are useful to your target 
audience. Construct a Usability Test that includes a list of tasks that requires them 
to select choices as they navigate through your site. Include some simple grading 
scheme (for example, 1- 5; where 5 is most useful) alongside each task in the list 
so that participants can evaluate the effectiveness of the cues.  
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Step 3: Provide each participant in this test with your usability punch list.  
Instruct them to evaluate these cues within the context of the page and website. If 
this were a real world situation, you would also test the usability of your website 
among participants outside your target audience using the same procedures 
applied to your target audience. You could thus compare the results of the two 
groups and depending on scores, modify the context and choices to better achieve 
your marketing plan objectives. 
 
TEST YOURSELF: Does the purpose, objective, and specification corresponds? 
Is the information accurate? Does the feedback you receive from the usability test 
yield consistent results with your design specifications and market plan purpose? 
Does pattern of access reflect website purpose and audience? Do the needs and 
objectives of your target audience correspond with respect to web presentation?  

 
At the conclusion of this lab, you will have confirmed your web site for coherent and 
consistent context, content, and choices. 
 
 
Additional Resources 
 
Reference material 
http://www.benedict.com/ 
This site is an excellent resource for information pertaining to the copyrighting material. 
 
http://dir.yahoo.com/Computers_and_Internet/Internet/World_Wide_Web/Evaluation/ 
This Yahoo listing links to a variety of sites offering tools and methodologies for the 
evaluation of web context and content. 
 
http://www2.imagiware.com/RxHTML/ 
Select Single Page Analysis to use the Dr. HTML validation tool to evaluate your use of 
HTML code.  
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Lab 5 Goal 
These five labs will demonstrate your proficiency in completing each stage in the life 
cycle of proposing, designing, and marketing an ecommerce website. The fifth stage in 
this lifecycle is the deployment phase where the marketing plan and design 
specifications. 
 
Objectives 
Final Presentations. This 2hr provides the students with the opportunity to show-off their 
online resumes to their classmates. Depending on class size, students will have 
approximately 7-15 min each to present their marketing plan and website, as well as any 
other supporting documentation. Other sources of relevant material are listed in the 
Additional Resources section of this lab.   
 
Topics Covered 
Topics covered in this lab include 

Presenting your marketing plan and website to an outside group • 
 
Requirements 
You will need a marketing plan. 
You need web design specifications. 
You need a usability test form and test results. 
 
 
Instructions 
Section 1: Prepare a marketing presentation 
Pretend you were addressing members of a firm to whom you have applied for 
employment or groups of venture capitalists from whom you want financial support.  
Separate yourself from your role as web designer. In critiquing your website prior to 
preparing your presentation, evaluate it’s information, design, and implementation with 
respect to effective communication of some idea or concept.  These labs focus on YOU 
as a marketable product.  How well does your presentation of planning, designing, 
testing, and deploying this online resume communicate your abilities as a desirable 
product.  Your critique should include how comprehensively you gathered information 
about your target audience and general content, as well as the performance of your 
website. Since the ultimate goal is effective communication through different media, your 
critique should also include relevancy of your website and whether your stated purposes 
for target audience were met. 
 

Step 1: Evaluate your own presentation (marketing plan and website) in terms of 
context, content, and choices according to general categories of design, 
performance, and usability. 
 
Some questions that pertain to design:  

• Does the site exhibit coherent, balanced design that supports user focus? 
• Does the site exhibit repeated patterns and consistent choices with 

variation for expressiveness? 
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• Does color complement purpose and objective? 
 
Some questions that pertain to performance: 

• How long does it take to retrieve an entire page (it’s cost to the user)? 
• What data appears on the page first during the refresh cycle?  
• How quickly can a viewer navigate from one cluster of information to 

another? 
 
Some questions that pertain to readability/usability:  

• Does any one thread of data “flow” from page to page?  For example, does 
My Web Site Home Page lead to My Experiences, which leads to My 
Internet Work, which leads to an example of a website I have designed?  

• Do navigational choices appear consistent from page to page? 
• Do are the placement of choices where you would have expected them? 

 
Step 2: Critique other presentations according to how your fellow students are 
targeting their audience.  For example, if the emphasis of a marketing plan and 
website is to secure full-time employment in an accounting firm, evaluate the 
website within the more narrow context of a specific industry or profession. If, 
alternatively, a student’s marketing plan has targeted consulting work as a web 
designer, you need to assume the broader context of some member of the general 
Internet population.  
 
TEST YOURSELF (as a reviewer): Does your audience have a specific purpose 
for using the online services like the Web? Is this specific purpose available 
elsewhere on the Internet? Does the target audience have accessibility? 
Does site provide unique goals not found anywhere else on the Internet? 
Does purpose match objectives and specifications and is thus, self-consistent? 
How is domain integrity and accuracy within the website maintained? Is the 
information correct? Is internal access balanced with external references and are 
these references regularly maintained for integrity and accessibility? 
Are objectives meeting the needs of the target audience? 
 
TEST YOURSELF (as a presenter):  Did you effectively answer impromptu 
questions and handle criticisms well “on your feet”?   Were you able to use your 
presentation in front of strangers as an opportunity for you to not only 
demonstrate your depth and breadth of knowledge and interpersonal skills but 
also perhaps gain a new perspective on your project? 
 
An example of questions that probe your past experiences for character traits are 
important to recognize, but even better to anticipate.  What traits are these 
questions attempting to assess? 

• Give an example of how your web design builds enthusiasm in about your 
product.  

• Give an example of how your design persuades other people to take action 
regarding your product.  
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• Give examples of how you organized your project in order meet the 
project deadline.  

 
The first two examples exemplify leadership skills; the last demonstrates time 
management skills.  Use every opportunity you have to “show your stuff.” 

 
At the conclusion of this lab, you have assumed the role of both creator/presenter and 
interviewer/reviewer.  Both experiences are important in successfully completing an 
ecommerce project. 
 
Additional Resources 
http://www.uwec.edu/Admin/Library/Guides/tencs.html 
This easy to use webpage lists ten separate criteria for the evaluation of an Internet 
resource. Notice how purpose, content, and style work together to provide an excellent 
example of effective communication. Could you use such a format to market yourself? 
 
http://www.agecon.msstate.edu/house/AEC3133/marketing/tsld001.htm 
This is an actual PowerPoint slide presentation converted to HTML. How old is it? What 
version of PowerPoint did the author use? Could they have put some biographical 
information somewhere for an informed user to find? 
 
http://www.business-plan.com/sitemap.htm 
Notice the business plan in portable document format. Many sites provide snapshots and 
partial chapters of products that can be very useful.  Also notice the use of /PowerPoint 
slides to provide online information. 
 
http://www.taos.com/resumetips.html 
These ten technical tips are just as relevant during this presentation as they were when 
people mailed resumes to employers!  As Tip #5 states, “Don’t sell yourself short. Treat 
your resume as an advertisement for YOU.” 
 
http://www.another_lesson.com 
This is meant to be a fictitious website; don’t bother using it. If you are actually reading 
this message, you can now also appreciate the difference between listing references as 
opposed to annotating references; the former is data, the latter is information. As an 
author/creator/designer, you gain credibility by providing content, not just data. I got you 
to read the endnotes, didn’t I? An occasional personal comment (in formal presentations, 
keep it very, very, very small and decidedly irreverent) and a little humor help too. 
Remember: the business of living is serious enough!  
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